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NEXTDENT 300 INTRODUCTION

The NextDent 300 3D printer system is a Multi-Jet Dental Printer. The solid imaging 3D printer produces digital dentures from
3D solid Computer-Aided Design (CAD) models and through the 3D printer system client software. The primary features of the
printer are the user interface, build chamber including the print engine, and the material delivery module (MDM), which contains
the materials and waste bag.

Improvements

3D Systems may (but shall not be obligated to) make improvements to this document from time to time. However, the Licensed
User acknowledges that at any time after the expiration of the date of issuance, 3D Systems may institute a periodic charge or

fee payable by the Licensed User in return for ongoing receipt of improvements. It is the responsibility of the Licensed User to
provide 3D Systems with current information as to its name and address. The Licensed User also undertakes to notify 3D Systems
promptly in the event that it considers any of the data contained in this document to be incomplete or erroneous in any respect, in
connection with the Licensed User's particular or general use.

FCC Notice
United States

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used
in accordance with these instructions, it may cause harmful interference to radio communications. Operation of this equipmentin a
residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his/her
own expense.

Canada
This Class A digital apparatus complies with Canadian ICES-003.
European Union

CAUTION: This is a Class A product. In a domestic environment, this product can cause radio interference in which
case the user could be required to take adequate measures.

Korea

MATERIALS FOR NEXTDENT 300
Build: NextDent Jet Teeth HW
Build: NextDent Jet Teeth B4
Build: NextDent Jet Base LT
Support: Visijet M2 SUP
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NEXTDENT 300 IMPORTANT SAFETY INFORMATION

CAUTION: IMPORTANT SAFETY INSTRUCTIONS - READ AND FOLLOW THESE INSTRUCTIONS BEFORE OPERATING
THE PRINTER SYSTEM.

Introduction

You must be properly trained and have read this manual before operating the NextDent 300 system. Also, anyone assisting you
must be properly trained. After you are trained, always follow the safety guidelines and procedures in this section before operating
the NextDent 300

Customer Safety Program
Before using the NextDent 300, customers must have a safety program in place. The safety program should do the following:

+ Label and point out hazardous equipment, materials, and procedures.
+ Explain what to do in an emergency situation.

+ Provide information about the hazards of equipment and materials in the form of Safety Data Sheets (SDSs). The SDSs are
provided with all materials supplied by 3D Systems.

The information in this chapter supplements the customer's existing safety program. It points out safety considerations that
specifically concern the NextDent 300 system.

Levels of User

WARNING: DO NOT ATTEMPT TO PERFORM ANY PROCEDURES DESCRIBED IN THIS MANUAL UNLESS YOU HAVE
READ THROUGH THE ENTIRE MANUAL FIRST.

WARNING: THE NEXTDENT 300 IS NOT SUITABLE FOR USE IN LOCATIONS WHERE CHILDREN ARE LIKELY TO BE
PRESENT.

There are two levels of users of the NextDent 300, based on the amount and type of training the user has received. The two levels
of users (operators and certified service personnel), are described below.

Operator

Operators are trained to operate the system and perform all the necessary tasks to build a part and perform basic preventative
maintenance as outlined in this manual.

Safety Symbols and Definitions

Radiation: Invisible UV radiation is accessible in the vicinity of this sign or behind the panel. Radiation can cause
eye injury or blindness, burn injury and/or fire. Access panels are for service only and should be opened only by
certified service personnel.

Electrical Shock: High voltage electricity is accessible in the vicinity of this sign or behind the access panel. High
voltage can cause severe burns or death, as well as fires. Access panels are for service only and should be opened
only by certified service personnel or trained maintenance personnel.

Hot Surface: A hot surface is accessible in the vicinity of this sign or behind the access panel. Avoid contact. Hot
surfaces can cause burn injury or fire. Allow surface to cool before touching. Access panels are for service only
and should be opened only by certified service personnel or trained maintenance personnel.

Rotating Blades: KEEP FINGERS AWAY FROM FAN: Putting fingers in way of moving fan can cause serious injury.

Sharp Element: KEEP FINGERS AWAY FROM SHARP OBJECTS: Putting fingers in way of sharp objects can cause
serious injury.

WARNING: INDICATES THE POSSIBILITY OF LOSS OF DATA OR DAMAGE TO EQUIPMENT.

DANGER: INDICATES THE POSSIBILITY OF INJURY OR DEATH TO PERSONNEL.
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DANGER: THIS GLOBAL HARMONIZED SYSTEM LABEL FOR LOW LEVEL TOXICITY. THIS INCLUDES RESPIRATORY,
SKIN, AND EYE IRRITATION, SKIN SENSITISERS AND CHEMICALS HARMFUL IF SWALLOWED, INHALED OR IN
CONTACT WITH SKIN.

Hazardeous Material: This Global Harmonized System label for Corrosive chemicals, may cause severe skin and
eye damage and may be corrosive to metals.

WARNING: THIS GLOBAL HARMONIZED SYSTEM LABEL IS FOR LOWER SYSTEMIC HEALTH HAZARDS

WARNING: THIS GLOBAL HARMONIZED SYSTEM LABEL WARNS HAZARDOUS TO AQUATIC LIFE AND THE
ENVIRONMENT.

Wear Protective Gloves: Wear the appropriate gloves when required. For example, when touching surfaces that
may contain or have been exposed to materials, wear nitrile gloves. Heat gloves are necessary when touching
surfaces that may be hot to ensure burns don't occur. Ultra Violet Radiation: UV light hazard lab safety symbols
will appear near ultraviolet (UV) light areas to warn personnel of the potential dangers.

Pinch Point: a mechanical hazard that occurs when two objects move toward each other, trapping or injuring a
body part.

Electrical Shock: A dangerous situation that could lead to an electric shock, burn, or fire
Belt Entanglement: A situation where a person's hand gets caught in a machine's moving parts, belts, or chains.

Cutting Point: a situation where a person'’s fingers could be cut by a machine or tool with moving parts
‘m
{

Safety Guidelines

General
The 3D printer system is designed with built in safety features, improper use can cause injury to personnel.
Follow these safety guidelines when operating the printer:

+ Read and follow all 3D printer system instructions. Printer should only be operated by trained personnel.

+ Follow all safety rules and heed all cautions and warnings in this guide.

+ Do not attempt to open top door while printing.

« Do not use any material without reviewing the Global Harmonized Standards/Safety Data Sheet (GHS/SDS).

+ Dress power and communication cables behind printer to prevent tripping.

+ Do not attempt to access, service, or adjust printer components or perform procedures without reviewing the documentation
for user accessible maintenance routines unless specifically trained to do so.

+ Only certified service personnel that have completed the 3D Systems service training may perform tasks they are authorized
and certified to complete.

+ Do notignore warning signs posted during 3D printer system service operations. If an error message appears on the 3D printer
system's User Interface refer to "Troubleshooting Section" within this guide depending on the error, before resuming operation.

« To prevent potential skin irritation and sensitization due to contact with waste material or uncured Part Material, follow all
guidelines in the following sections.

Safety Notice

CAUTION: Use of controls or adjustments, or performance of procedures other than those contained in the
operation, maintenance or any other manual provided with this machine may result in hazardous radiation
exposure.

All service to the machine and other components requiring safety switch override shall only be performed by 3D Systems service
personnel, their authorized agents, or personnel who have been service-trained by 3D Systems.
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Label Installation Diagram

The machine has many warning labels throughout. This section details what those warning labels are, how many of each warning
label is on the printer, and the locations of each type of label. It is important to use the machine with extreme caution to avoid
situations that may be hazardous. The numbers in the Item column below correspond to the numbers in the images that follow.

The numbers in the Item column below correspond to the numbers in the images that follow.

ITEM DESCRIPTIO QTY LABEL LOCATION
N

1 Product label - 1
Contains
system
information
and
certification
symbols

2 Caution - Risk 1
Group 2 -
Possible
hazardous
optical
radiation
emitted from
the product.
Do not stare at
operating
lamp. May be
harmful to the
eyes.

3 Hot Surface 1
Warning - Hot
surface in 25
vicinity of
sticker when
machine is
operating

4 Cutting of 1
fingers - A
situation
where a
person's hand
gets caught in
a machine's
moving parts,
belts, or
chains.

5 Cutting blade - 1
A situation
where a " 133
person's ‘
fingers could
be cut by a
machine or
tool with
moving parts.
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ITEM

DESCRIPTIO QTY
N

Hot Surface 1
Warning - Hot
surface in
vicinity of

sticker when
machine is
operating

Electrical 1
Warning -
Possible
electrical

hazard on or
behind panel
with sticker

Hand 1
Entanglement,
Notched Belt
Drive - A
situation
where a
person's hand
gets caughtin
a machine's
moving parts,
belts, or
chains.

Pinch Point 1
Label -
mechanical
hazard that
occurs when
two objects
move toward
each other,
trapping or
injuring a
body part.

LABEL

LOCATION

3D Systems, Inc.

p/n 33-D386, Rev. C



ITEM DESCRIPTIO QTY LABEL LOCATION
N

Hot Surface 1
Warning - Hot
surface in
vicinity of

sticker when
machine is
operating

Protective Equipment/First Aid

Follow recommendations for protective equipment and general first aid procedures to minimize the risks from part material
exposure. If professional medical attention is necessary, take the Global Harmonized Standards/Safety Data Sheet (GHS/SDS) for
the exact material involved to the attending physician.

Note: Always wear 100% nitrile gloves and lab coats when handling any part or waste material. Latex gloves are not
chemical-resistant and are not recommended.

Note: In the event of a leak or spill of uncured part material, wear safety glasses with side shields to provide eye
protection.

CAUTION: Because of the 3D printer system's built-in engineering controls, respiratory protection is not
necessary during normal operation. A NIOSH-approved (or equivalent) dust mask is recommended when dry
sanding cured material parts.

CAUTION: Always wear protective sleeves or a lab coat when doing anything around the materials. When skin
comes in contact with materials they can cause an allergic reaction that can be harmful to skin.

Health Hazards / Irritant

Irritant

+ Any chemical may exert harmful effects if it contacts or enters the body. Uncured material is a sensitizer, and can cause allergic
reactions if it comes in contact with skin. Always wear nitrile gloves when handling material. Refer to personal protection
equipment for more information. To avoid sensitization, do not allow uncured material to contact skin. Consult the GHS/SDS for
specific information about the sensitization potential.

+ If skin comes in contact with uncured material immediately wash with cold water and soap.

Inhalation/Ingestion

+ Under normal operation, inhalation is not an expected route of entry.

+ Ingestion - Uncured part material is toxic if ingested.

+ Because uncured material is toxic if ingested, it must not be present where food and drink are stored, prepared, or consumed.
After handling materials, wash hands with soap and cold water before consuming or preparing food.

Handling Finished Parts

* Finished (cured) parts can be handled or disposed of the same as standard household plastic products. parts are not recyclable.
materials are not intended for and cannot be used for medical implant, food or drink handling applications.

« Exposure control - The 3D printer system has a variety of built-in engineering controls which are designed to prevent operator
exposure. Do not try to change or disable these controls.

Skin Contact

« Uncured part material is a sensitizer, and can cause allergic reactions if skin comes into contact. When handling any part or
waste material, always wear 100% nitrile gloves and lab coats.

* Should skin come into contact with uncured part material, wash thoroughly with soap and cold water and immediately remove
contaminated clothing and shoes. Do not use hot water or solvents to wash hands, as it will result in absorption through the
skin. If skin is irritated, seek medical attention. Dry-clean contaminated clothing and discard contaminated shoes and leather
products in accordance with applicable regulations.
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Eye Contact

+ Safety goggles with side shields should be worn to prevent accidental splashes into the eyes. If material comes in contact
with the eye, flush immediately with large amounts of cold water for 15 minutes, avoid sunlight, fluorescent light, and other
ultraviolet light, and obtain immediate medical attention. Eye wash facilities and a first aid kit should be readily available and
close to the 3D printer system.

Contact Lenses

+ Wearing contact lenses is not recommended if handling liquid materials. If material splashes into eyes when contact lenses are
worn, flush eyes immediately with water. Verify that flushing has removed the contact lens from the eye(s). Protect eyes from
light and obtain immediate medical attention. Discard contact lenses that come into contact with liquid material.

Fume Inhalation

+ Under normal operation, inhalation is not an expected route of entry. Always work in a well ventilated area when using
materials and avoid breathing vapors. If inhaled, remove the personal to fresh air. Give artificial respiration or cardiopulmonary
resuscitation (CPR) if required. If breathing is difficult, give oxygen. Obtain immediate medical attention.

Ingestion

+ Uncured part material is toxic if ingested. Obtain immediate medical attention.

Hygienic Practices

+ Because uncured material is toxic if ingested, it must not be present where food and drink are stored, prepared, or consumed.
After handling materials, wash hands with soap and cold water before consuming meals, breaks, smoking, applying cosmetics,
using toilet facilities, and after work.

+ Employees should be alerted of the need to clean and rinse off any contacted surface promptly in order to prevent further
contamination. Ensure a convenient washroom location is provided with access to soap, water, and disposable paper towels.

+ Tools contaminated with part material should be cleaned prior to reuse. Solvents such as denatured alcohol or Isopropyl
Alcohol (IPA), are normally required to clean equipment and tools. Wash with soap and water to remove any traces of excess
part material or solvent.

Material Handling and Safety

Prior to using the NextDent 300, users should be aware of potential hazards which may result in exposure to uncured part material,
such as removal of the material waste bag and handling part material cartridges.

Emergency (GHS/SDS)
Chemtrec USA (800) 424-9300; Europe +1-703-527-3887

Consult the materials Global Harmonized Standards/Safety Data Sheets (GHS/SDS) for information on specific materials. For
further information on this and related topics, consult the 3D Systems - Materials website at http://www.3dsystems.com/support/
materials/msds.

Packaging Inspection

The material cartridges are packaged in shipping cartons. Upon receipt of material shipments, inspect cardboard carton exterior
for signs of damage and leakage. If leakage is observed, DO NOT open carton, and contact 3D Systems's Technical Support Hotline.

NEXTDENT 300 PART MATERIAL SUP WAX SUPPORT MATERIAL
Shelf Life 2 Years 5 Years
Climate Cool, dry area with adequate ventilation
Temperature Range 60°F (16°C) to 80°F (27°C)
Maximum Storage Temp 95°F (35°C)
Environmental Conditions No direct sunlight, heat, flames, or UV energy. Do not expose materials to heat at or

above 230°F (110°C) , flames, sparks, or any source of ignition.

Recertification Date

Always check material "Recertification Date" before use. If the cartridge has reached its Recertification Date, your 3D Systems
certified Partners or 3D Systems Technical Support can assist with questions on material requiring recertification.
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Support material is loaded on the left side of the material drawer (white). Build material is loaded on the right side of the material
drawer (black). Before loading cartridges into 3D printer system, inspect the cartridges for signs of damage or leakage. Do not load
a damaged or leaking cartridge. Dispose of material cartridge according to local regulations.

Storing a Partially Used Material Cartridge

It is important not to lay material cartridges that are partially used on their side. Doing so will cause material to seep through the
vent cap and clog cap. This will cause damage to the material cartridge if used for a later print. To store a partially used Material
Cartridge, place it upright in a NextDent 300 Cartridge Holder and tighten the vent cap.

3D Systems, Inc. 8 p/n 33-D386, Rev. C



Material Storage

Material should be stored in their original containers, according to the guidelines given in the GHS/SDS included with the material.
Protect material from sunlight and ambient room light.

CAUTION: Never mix different materials.

Disposal

Disposal of fully cured parts are not subject to regulations of any known agency worldwide. support material cartridges may be
disposed of in ordinary office trash.

Support Material

Support material has no known regulatory requirements and may be disposed of in ordinary office waste.

Cured Part Material

Finished (cured) parts can be handled or disposed of the same as standard household plastic products. Printed parts are not
recyclable. Materials are not intended for and cannot be used for medical implant, food, or drink handling applications.

Uncured Part Material and Waste

Uncured part material is classified as regulated, and in some areas hazardous; requiring special packaging, transportation, and
disposal. The disposal of partially cured or uncured part material must comply with all local, state, and federal environmental safety
regulations. Applicable part "waste" includes cartridges (empty or full) and waste pans. Any materials used to clean up uncured
part material should be disposed of in the same manner as uncured part material.

Dispose of your uncured parts and waste materials according to your local environmental regulatory agency. If assistance is
needed, contact 3D Systems certified Partners or 3D Systems Technical Support.

To find out facility disposal requirements, contact a local waste disposal provider. (Local environmental regulatory agency should
have a list of qualified providers.) You will need to give disposal service provider a copy of the part material GHS/SDS (Global
Harmonized Standards / Safety Data Sheets), and possibly other forms included in the Appendix of your Material Handling Guide,
such as Waste Profile Worksheet and SNUR (Significant New Use Regulation - U.S. only). A report will be provided, indicating
disposal requirements, as well as a quotation for regularly scheduled pickups. If assistance is needed locating a waste disposal
provider, or completing a waste disposal form, contact your local 3D Systems certified reseller or 3D Systems Technical Support.

3D Systems assumes no liability or responsibility for proper disposal of uncured part material. Proper disposal of uncured part
material is the sole responsibility of the user.

Spilled Material

Spills of material are HIGHLY UNLIKELY, and should NOT occur in normal operation of the 3D printer system. If a leak occurs, it is an
indication of a serious 3D printer system malfunction.

The first priority is to protect users from inadvertently touching material. Spills of support material can be cleaned without use of
protective gear, and disposed of as office trash. Handling uncured part material requires use of nitrile gloves and other personal
protective equipment to ensure no direct contact with uncured part material. If you don't know which material it is, assume it to be
uncured part material, and handle accordingly - with the recommended personal protective equipment.

Promptly remove spilled material, dispose of waste material, and clean up materials per local regulatory requirements. Suspend
use of the 3D printer system until you contact 3D Systems Technical Support for a service visit to determine and repair the source
of the leak.

Small spills of uncured liquid part material can be cleaned up using disposable towels, non-reusable rags, or absorbent materials
such as sawdust, clay, diatomaceous earth, or activated charcoal. If spilled material is hot (liquid), wait until it cools before wiping
up. After wiping up the spill, wipe surface with denatured or isopropyl alcohol and clean thoroughly with soap and water.

CAUTION: Never put sawdust, clay, diatomaceous earth, or activated charcoal inside the printer, doing so will
damage the printer.

Consider avoiding placement of the 3D printer system over carpeting, or consider use of barriers to avoid the possibility of carpet
damage if spills were to occur.

Advise service provider involved of the spilled material, and provide GHS/SDS and other material information prior to contact with
the material. Advise them of disposal requirements for part material and clean-up products if part material (uncured) is the spilled
material.
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Tools contaminated with part material should be cleaned prior to reuse. Solvents such as denatured alcohol or Isopropyl Alcohol
(IPA), are normally required to clean equipment and tools. Wash with soap and water to remove any traces of excess part material
or solvent. Contact solvent suppliers for information on proper handling of solvents if used for clean-up.

Some cleaning solvents are highly flammable such as denatured alcohol and isopropyl alcohol. Before using solvents to clean and
remove uncured part material, be sure read and follow the solvent supplier safety precautions and recommended usage.

Flammability Hazards

Though the U.S. Department of Transportation does not consider materials a "flammability hazard," they do classify them
"combustible" based on flash points. Material containers may rupture when exposed to extreme heat. Use National Fire Protection
Association Class B extinguishers such as carbon dioxide, dry chemical, or foam.
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NEXTDENT 300 PRINTER FEATURES

Build Mode

The NextDent 300 3D Professional System features a single build mode and improved print speed to deliver high fidelity prototypes
for a variety of applications. The build area is 518 x 381 x 299 mm (20.4 x 15 x 11.8 inches) (x, v, 2).

+ HD Mode: Allows the user to build high-resolution parts with exceptional surface finish and superior accuracy. HD mode prints
at 800 x 900 x 800 micron layer thickness.

Build Mode
Resolution (xyz)

Build speed (in/hr) in Z
mm/hr

Build speed (hr/in) in Z
hr/mm

Build Volume (xyz)

Accuracy - per inch of part dimension
typical

Minimum Feature Size

Layer Thickness

Build Material

Material

Material Delivery

Support Material

Part Stacking
No Enclosure

Application

Part Stacking and Nesting

NEXTDENT 300 - PRINTER FEATURES
High Definition (HD)

800 x 900 x 790 DPI

1 Lane: 0.29 2 Lanes: 0.22 3 Lanes: 0.14
1 Lane: 7.3 2 Lanes: 5.5 3 Lanes: 3.5
1 Lane: 3.5 2 Lanes: 4.5 3 Lanes:7.3
1 Lane: 0.14 2 Lanes: 0.18 3 Lanes: 0.29

518 x 381 x 299 mm (20.4 x 15 x 11.8 inches) (x, Y, z).

+/-0.004 inch per inch (+/-0.1016 mm for 25.4 mm) of part dimension

500 pm
32pm layers
NextDent Jet Teeth HW

NextDent Jet Teeth B4
NextDent Jet Base LT

UV Curable Plastic

Part material is delivered in 1 kg. plastic bottles
Support material is delivered in 1.75 kg

Each MDM holds 8 bottles of material, allowing for a total of 2 bottles of support
material and 6 bottles of build material.

Visijet M2 SUP

YES

NO

High Definition printing mode provides a balance of speed and print quality. It is well

suited for most general print jobs and is perfect for high fidelity prints of models for
design verification, functional testing and other applications.

Stacking: The user can utilize the entire build area by stacking parts vertically in the z-direction to fill up the entire build envelop
with parts. The user can control the space between layers to minimize support material usage and build time. Hours can be saved
by stacking parts and submitting single, long builds overnight and weekends. Nesting capability allows parts to be placed within
the boundaries of one another but not overlapping the part structure itself.

3D Systems, Inc.
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Simultaneously use Two Materials for Part Building

The NextDent 300 provides the simultaneous use of two build materials along with a support material. The 3D printer system has a
total of six material channels. Each MDM holds eight bottles of material, allowing for a total of two bottles of support material and
six bottles of build material. Support material is loaded into the left side of the machine, while build material is loaded into the right
side.

The following build materials are available for the NextDent 300:
NextDent Jet Teeth HW

NextDent Jet Teeth B4

NextDent Jet Base LT

The following support materials are available for the NextDent 300:
* Visijet M2 SUP

Note: For more detailed information regarding NextDent 300 material characteristics please visit the material
characteristics page in the customer support site.
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NEXTDENT 300 AT A GLANCE

The NextDent 300 Printer

The NextDent 300 is a Dental Printer. The solid imaging 3D printer system produces

plastic prototype parts from 3D solid Computer-Aided Design (CAD) models. File types

include: .stl, .ctl, .obj, .ply, .zpr, .zbd, .amf, .wrl, .3ds, .fbx, .mjpddd, .bdz, .iges, .igs, .step, .stp and .slc, The primary components are
the touchscreen, build chamber, material delivery modules (MDMs), and waste drawers.

The three dimensional solid parts built by the 3D printer system consist of one support material and one (or two) part materials.
The support material is a wax based material providing adhesion to the print platform, as well as, providing supports for the part
material to build the model.

The part material used to build parts is an ultraviolet (UV) curable material. After a layer of material is deposited in the build
chamber, the part is exposed to a UV flash lamp. The UV energy is absorbed by the material converting the liquid build material to
a solid polymer. When the build is complete the part is adhered to the print platform by means of the support material.

Specifications and Requirements
Total Machine Footprint (xyz) 1183mm x 740mm x1077mm 46.6" x 29.1 x 42.4"

Electrical Requirements Each 3D printer system requires use of a dedicated circuit
that will allow for 100-127 VAC, 50/60 Hz, 15A, single phase or
200-240 VAC, 50/60 Hz, 10A, single phase.

Network Ready Built-in Ethernet - only used for 3D Systems' 3D Connect
service.
Built in USB Port

Touchscreen Control Panel

The NextDent 300 articulating touchscreen control panel provides a graphical user interface (GUI) for the user. With the exception
of submitting print jobs, the touchscreen control panel provides full control of the 3D printer system including:

+ Setup

+ Selecting, starting, pausing and aborting print jobs

+ Diagnostics

+ Test prints and demo prints

The full functionality of the 10" touchscreen control panel is described later in this chapter.

3D Systems, Inc. 13 p/n 33-D386, Rev. C



Material Delivery Module (MDM) and Waste Bag
The 3D printer system has one material delivery module (MDM), shown open in the figure below. The MDM holds six bottles of
material on the right side., and a total of 2 bottles of support material on the left side of the MDM.

The support material is delivered in 1.75 kg. plastic bottles and the part material is delivered in 1 kg. plastic bottles. The bottles are
placed in the machine's MDM. The NextDent 300 allows for the simultaneous use of two different part materials.
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The NextDent 300 has one waste bag. The waste bag can be accessed by opening the MDM.

Build Chamber

The figure below shows the NextDent 300 with the build chamber door open. The user will access the build chamber to install

a print platform before each build and to remove the completed parts at the completion of a build. The build chamber door is
equipped with an interlock which prevents the user from accessing the build chamber during a build. This prevents user access to
moving parts and protects the user from exposure to the UV curing lamps.

3D SPRINT

3D SPRINT is a client workstation software package that is used to manipulate the .stl, .ctl, .obj etc. files that are subsequently sent

to the NextDent 300 as print jobs. Print jobs cannot be submitted locally (at the 3D printer system itself), and must be submitted
through 3D SPRINT.
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NEXTDENT 300 3D SPRINT SOFTWARE

3D SPRINT™ is a client application that is offered for your printer. Please review the "help" section that covers the entire application
and will also help you to fully utilize the power of 3D SPRINT.

If you are using this application for the first time, please read the "Help" document thoroughly to get a basic understanding about
the application and its uses.

To open and use the help documentation, click here.

Shrink Compensation for Part Material

Material shrinkage occurs in thermoplastics as they transition from liquid state to solid (change in density). In the case of photo-
polymers used in the Multi-Jet building process, this shrinkage can occur during the curing stage of printing. 3D Sprint has features
built in to allow a user to compensate for the natural shrinkage of the material and also fine tune the accuracy of a part. The
Material Shrink Compensation Tools are provided for this purpose. The kit includes instructions, a worksheet, two .STL files and will
explain the process for entering shrink compensation and fine tuning part accuracy using scaling factors.
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NEXTDENT 300 PRINTER SETUP

6.1 NextDent 300 Power On Printer

Switch power on located in the back of the printer to power on the device. Once the printer is switched on it should remain on
unless it will not be used for a significant amount of time (>60 days). UI will begin to power up. This may take a minute or two for
the screen to come on. When the Ul is booted up the 3D Systems logo will appear and then the Status screen will appear.

6.2 NextDent 300 Changing Waste Bag

The UI will instruct the user when it is time to change the Waste Bag. Follow these steps to change the waste bag.

Note: Even though the waste bag may not appear full when the user is notified to change it, it is highly
recommended to replace the waste bag when prompted to avoid unnecessary overflow and mess. When waste

bag has been changed ensure you confirm the level has been reset to zero.

1. Verify that the printer is in READY.
2. Select Materials tab.
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Wearing protective Nitrile gloves, open the MDM drawer.

Remove waste bag and dispose of bag according to local regulations.

5. Inspect the waste bin for any remaining waste. If necessary, wipe out any waste that exists with the lint free cloth and isopropyl
alcohol.

»

Note: The waste bag is stuck to the liner when you attempt to remove it, replace the entire liner and bag to
prevent the bag from tearing and causing material to leak into the receptacle. Waste bags can be ordered
using part number 310248-00. With each order you will receive 30 bags and 1 liner.

6. Confirm on the printer Ul when you have completed replacing the waste bag.

6.3 NextDent 300 Material Cartridge Removal and Installation

When a material cartridge is empty and needs to be replaced, or if a partially filled container needs to be replaced with a
full container, perform the following procedure.

Note: It is important to verify the type of material currently in the MDM before proceeding with these steps.

Removing Material Cartridge

Note: Cartridges cannot be removed from a cold printer. The printer must be warm before drawer will open and
cartridges can be removed.

Note: The software verifies that material cartridges are genuine to prevent possible compromised part quality
and print head damage from the use of non-genuine material cartridges. Material cartridge information and
certain printer performance parameters are collected, but no personal or design data are collected.
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The MDM drawer is a push/push mechanism. Push to open drawer, push to lock drawer.

1. Open the MDM drawer by pushing in at the recessed dimple.

2. Pull the MDM drawer open.
3. Turnthe material cap a 1/2 turn to clockwise to tighten the vent cap.

4. Press the release button on the front. You will hear the cartridge release. Pull the cartridge out of the slot.
5. Dispose of the empty cartridge according to local regulations.
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6. Wearing nitrile gloves and either protective sleeves or a lab coat to protect arms, use a disposable paper towel and wipe all
material from the container seal assembly, if necessary you can use some isopropyl alcohol on the paper towel to wipe up the
excess material.

Note: It is important to always wear nitrile gloves and either protective sleeves or a labcoat to protect arms
when coming in contact with materials to avoid getting materials on skin. Contact with skin may cause an
allergic reaction.

Installing New Material Cartridge

Note: For optimal use, a new or unused NextDent material bottle should be rolled on a NextDent bottle roller for
a minimum of 3 hours before being inserted into the printer. Additionally, bottles stored in the NextDent drawer
for more than 2 weeks should be re-rolled for at least 15 minutes before reinsertion.

What happens if you ignore bottle rolling guidance?

Pigmentation settling in the bottle and uneven color results.
Note: Support Cartridges cannot be installed into a cold printer. The printer must be warm before drawer will
open and cartridges can be installed.

To place a material cartridge into the MDM, perform the following steps:

1. Obtain a new material cartridge ensuring that it is the same material as currently installed in the MDM.
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2. If drawer is not already open, push to unlock drawer.

3. Pull open the MDM drawer.

Note: The steps to install a support cartridge are the same as installing a part cartridge.

Note: To install cartridges into the MDM drawer properly ensure that the small cap be installed away from the
user.

CAUTION: It is important to verify the cartridges have been audibly clicked into place, have material in them,
and the cartridge caps properly ventilated; otherwise the printer may not be able to pull material from the
bottles, potentially resulting in the following fault codes: 93-134 thru 137 - cartridge check needed

4. Place cartridge in slot and push down until you hear it click in place.

5. Vent each cartridge by loosening the material cap by a 1/2 turn counterclockwise.
6. Close the MDM drawer by pushing in the dimple at the top until it's latched securely.
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7. Check the material level under the Materials tab (C) on the UI to ensure cartridge is seated properly into MDM and ready to
print.

Note: Contact certified reseller partner or 3D Systems Customer Support when the UI continues to report an
empty cartridge even though the cartridge is non-empty and is seated properly in the MDM. Contact your
certified reseller partner first or contact 3D Systems Customer Support, whose contact information can be
found here.

6.4 NextDent 300 Print Platform Removal and Installation

Note: Make sure you are wearing Nitrile gloves and protective clothing before performing any of the following
procedures. Always protect yourself from possible exposure to materials. Always wash hands thoroughly with
soap and water after handling parts and/or material. Never eat or drink without washing hands first.

1. Ensure the printer is turned on and the Printer State is in Ready or Standby mode.

3D Systems, Inc. 23 p/n 33-D386, Rev. C


https://support.3dsystems.com/s/article/projet-mjp-2500-partner-customer-support

2. Select the Access Platform button next to the light bulb icon on the printer touch screen.

Note: The Access Platform button will not be available to select if the printer is not ready for the user to
access the print platform.

Note: When selecting the Access Platform button, if the printer is completing maintenance, there may be a
delay in accessing the platform. The printer will notify the user when the top door is unlocked and access is
allow
3. The printer will move into position in order to allow access to the print platform. When prompted, open the door to access the
print platform.
4. Lift to remove the platform.

5. Install clean print platform. Close top door. If it is placed correctly the platform will automatically lower and clamp the print
platform in place.

6. A message will display (see below) asking user to confirm that the platform is clean, verify the platform is clean.
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Note: Always be sure you are installing a room temperature print platform that is clean on both sides to
avoid any printing issues. Also, confirm that the print platform is free from damage due to any drops or dings.
Protruding metal on the platform may come in contact with the printhead and cause severe damage.

6.5 NextDent 300 Scale and Offset Wizard

For each M2 material, the "General" build styles in 3D Sprint are designed to give you accurate prints right out of the box. Please
use the "General" build style first and foremost to achieve part accuracy. However, if after measuring your parts you find that you
have issues achieving accuracy, you may use the "Scale and Offset Wizard" in 3D Sprint to troubleshoot such issues.

Each NextDent 300 printer will vary slightly in accuracy. If you have multiple printers, you may need to set the accuracy for each
one separately. To do this, click the "Printer" icon in the upper left corner, connect to a specific printer, and run the steps in this
section for each printer. Additionally, you will need to run the wizard for each Material,Print Mode, and Build Style combination you
use.

1~

LOAD
REFEREN...

1. Click the "Load Reference" button to load the accuracy models that will be printed.
2. Print the reference build on your NextDent 300, then post process the parts.
3. Click the "Printer Tools" button, then select the "Printer Settings" button.

4. Inthe "Printer Settings" window, select the build style you used to print the reference build, then select the "Scale and Offset
Wizard" button.
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5. Measure each part using calipers, micrometer, or height gauge, then input the measurement values to corresponding boxes in
the "Scale and Offset Wizard". Each measurement is repeated 4 times. Be sure to input the values for parts labeled with X, Y,
and Z before selecting the "Next" button.

Note: Before measuring, wipe each end of the measurement part with a paper towel to remove excess wax
remaining after post processing. Also be sure to wipe clean your measurement device before measuring.

o

Once all measurements are complete, select the "Next" button.

7. You can now see the calibrated slope and offset values. If you calculate a corrected slope and offset on your own, be aware that
the offset range will be limited to [ 0, -0.002 ] inches.

8. Select "Apply", and 3D Sprint will allow you to change the name of your new "Build Style". By default, the syntax includes build

material, print mode, and the date. You may add to the printer name as well if you have more than one NextDent 300 printer.

9. Be sure to press the "Set" button instead of closing the printer settings window. Pressing "Set" will not only set this new build
style for your current 3D Sprint build, it will also save the build style for future use.
10. You will now be able to select this style from the "Build Style" menu going forward, allowing you to build with these scale
factors at any time.
11. Remember that the Build Style is tied to the build material and print mode you are using. If you use a different print mode, build
material, or printer, you will need to run this wizard again for that combination. The software will automatically create "name
the new build style", but you can click the "Rename" button to rename it.
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12. When you select this build style in the future, you can verify that this is the style with scale factors applied by looking at the scale
and offset fields in the "Printer Settings" window.

13. Print your next build using this new build style. The accuracy of your parts should now be slightly closer to perfection.
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NEXTDENT 300 PRINTER POWER OPTIONS

The NextDent 300 printers will go into lower power modes when it has been idle for a period of time. After 120 minutes, the printer
will enter Standby mode. After 9 hours, the printer will enter Conserve mode. The UI status will display as in Standby during this
time. Sending a print job or interacting with the front panel will start warming up the printer. The printer can be placed in conserve

mode by selecting "Standby" in the Tools > Printer Shutdown tabs.

NEXTDENT 300 STANDBY CONSERVE
Low power mode (idle state) 120 minutes 9 hours
8 minutes 20 minutes

Ready State (from low power mode)

Printer Shutdown
If you do not plan on operating the 3D printer system on a regular basis and want to shut it down for an extended period of time,

follow these steps:

1. Verify that the printer is not building.
2. Select Tools (1) from the top tool bar.
3. Select Power Options (2) on the Tools side panel screen.

4. Next, select Printer Shutdown.

5. The next message that pops up is asking to confirm if you want to shutdown the printer. Select SHUT DOWN.
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6. The SHUTTING DOWN screen will appear next. This lets the user know that the printer is shutting down and not to take any
action.

7. A message will then come up that states it is now safe to turn the power switch off. Turn off the printer switch on the back of the
printer.

Note: Unless the printer will be idle for an excessively long time (>60 days) it is not necessary to shut it down.
Shutting down the printer will cause longer wait times for warming from a cold state.
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Note: Whenever the printer is powered down, wait 60 seconds before toggling the power switch back on.
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NEXTDENT 300 DENTURE PRINT & POST PROCESS PROCEDURE

Overall Process Workflow Description

Equipment and Materials List
Printer Setup:

*  NextDent 300 Printer
+ Starter Kit

« 1 kg bottle NextDent Gum LT

« 1 kg bottle NextDent Tooth White

+ 1 kg bottle NextDent Tooth Yellow

* 1.4 kg bottle VisiJet M2 SUP wax support

Resin Bottle Roller

* NextDent LC-3D Mixer
+ 3D Systems P/N: NMACNDLCMIXER3
Support Wax Removal:

* Freezer
« + Magic Chef 3.0 cu. Ft. Upright Freezer

*« Oven

*  Thermo Scientific Heratherm OMS60 Convection Oven
* P/N:51028121
+ Heated Ultrasonic Cleaner by Sharpertek

+ Model: SH500-15 L
* Mineral Oil 5 gallon pail

*  White Mineral Oil Light by W.S. Dodge Oil
+  W.S.Dodge Oil - An Independant Family Owned Business

Bead Blasting Process:
« Vapor Honing Technologies Wet Bead Blaster

+  Model: VH800P FL
+  VHB800P FL Closed Loop - Vapor Honing Technologies
+  25um Aluminum Oxide Media

*  P/N: 98201 - 55Ib/pkg
+ Aluminum Oxide Sandblasting Media 25 Micron (360 Grit) - 55Lbs - 98201 - Vaniman
+  8mm Boron Carbide Nozzle

+ Wet Blasting Equipment - Vapor Honing Technologies
Pumice Process:
+ Navajo Brand Pumice

*  Grade: 0-1/2 (0.04mm to 0.2mm - 80 to 325 mesh)
+ Hatho Special Lath Brushes
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* 13" Diameter, 12/pkg
*  P/N:75339353
+ Palatinal Brush

+ SKU: 1670152
+ Keystone #B20 Lathe Brush with Plastic Hub

+ 2.5" Diameter
+ P/N: 1170200
*  Muslin Buff Wheel

« 4" Diameter, 30 Ply
*  P/N:70910505
+ 26A Red Wing Lathe

* Y% HP, 2 Speed (1725/3450 RPM)
+  Model: 26A (120V/60Hz)

Fine Polishing Process
« Renfert Universal Polishing Paste

* P/N:5131000
*  Muslin Buff Wheel

* 4" Diameter, 30 Ply
« P/N:70910505
* 26A Red Wing Lathe

« % HP, 2 Speed (1725/3450 RPM)
*  Model: 26A (120V/60Hz)

8.1 NextDent 300 Print Job Setup

1. 3D Sprint Software:

+ Ensure 3D Sprint version 2025.2.0.1094 or newer has been installed (along with the appropriate Expose NextDent 300 patch
file applied) and launched.
2. Selecting Printer:

a. Select the “Print” tab along the top of the 3D Sprint window.

b. Select “Printer” from the Dynamic Tool bar ribbon menu.

c. Within the “Printer Configuration” window, do one of the following:

i. Select a pre-added printer
ii. Add a NextDent 300 printer via IP address in the “Find Printer” section
iii. Select a NextDent 300 Virtual Printer.

+ Set the Technology filter to “MJP” to more quickly find the NextDent 300 Virtual Printer.
d. Select either your network added printer (or the NextDent 300 Virtual printer) then click the right arrow. arrow.
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e. Ensure that the “Denture Material Set” is selected (highlighted blue) and that the Shade selection in the far right says “LT",
then click the right arrow.

f. Ensure that “HD"” mode is selected then click the right arrow.
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g. Ensure that the Standard style set “General” is selected (which contains pre-selected scaling factors for accuracy) and then
click the blue “Apply” button. Alternatively, if a previous custom style set was created you may select it at this time.

h. The main print platform window will now be visible where the previously selected settings can be verified in the lower right
hand corner:

Di-202
(NextDent 300)
ORLAFEIRY:
2] Denture Material Set
LT
HD
General
X: 294.051 mm (99.80%
Y: 211.525 mm (99.80%
Z: 144.67 mm (100.10%

)
)
)

3. Importing Dentures
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a.

b.

C.

There are three main denture CAD file parts (Teeth, Gum [aka Base], and Monoblock). Preferred files for creating dentures
are Teeth and Monoblock files. However, if only Teeth and Gum files are available, they can be used in the Import Denture

Tool to create a Monoblock file..

Note that the Import Denture Tool window will change depending on which options have been selected and what files are
available.

It is recommended that the “All In Folder” check box option (below image) be left unchecked for most cases.

i. Checking this box can be useful if there are multiple files for each component (eg. Teeth), however checking this box will

import ALL supported files including those in sub-folders.
Select the “Import” button on the Import Denture Tool dialog window to open a File Explorer style interface to select your
denture files. Alternatively, once the Denture Tool window is active you can drag and drop your files from your PC directly to

the 3D Sprint main print platform window.

i. Select the Teeth and Monoblock files and click Open.
ii. Alternately, if only the Teeth and Gum (Base) files are available, select these two files and click Open.

Ensure that the Denture Tool has correctly identified the CAD files as the correct denture parts, otherwise you may change

them with the drop down options.
If the Monoblock is needed (Teeth and Gum files only), then do the following:

i. Click the “Create Monoblock” button (not shown here).
ii. Once the Monoblock has been created, ensure that the Remove Gum check box is now selected as the gum file is no
longer needed OR under the Gum dropdown choose “None.”

3D Systems, Inc.
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g. The Case name uses the folder name of the imported files, but if needed can be changed in this Denture Tool window or can
be changed later in the “Parts List” window.

h. The Teeth Material color can be selected in the “Teeth Mat” drop down or it can be assigned later.

i. Checking the “Orient” and “Auto Place” boxes help automatically position the denture on the plate and is highly
recommended.

j. Click the “Set” button when everything in the Denture Tool window looks correct.

k. The denture will be placed flat on the build plate in an optimized position.

I. If importing additional dentures, ensure that there are no parts selected before returning to “Denture” -> “Import” as it will
try to merge the new files with any parts which have inadvertently been selected.

4. Denture Labelling

a. If desired, one can now label the imported denture using inlaid text with the denture engrave tool.

b. Simply select the information, place the box over the region in the desired denture and click enter. The default label color
is “BL" which gives the best contrast for most situations. However the color can be manually changed in the denture at a
subsequent step.
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c. The labelling will now be shown on your denture with a slight offset from the surface of the denture. It is raised only to
emphasize the text while within 3D Sprint but will be printed flush with the surface of the denture.

5. Offsetting Dentures

a. Dentures can either be offset one at a time or batch offset. Offsetting does take a few minutes per denture (depending on
CAD complexity) so be prepared if doing several at once.

b. Ensure the denture case name (or case names) is selected (highlighted blue) in the “Parts List” window.

c. Select “Denture” -> “Offset” in the Dynamic Tool bar ribbon menu.
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d. Inthe “Offset Denture” window, use the following default recommended settings:

i. i. Teeth =0.15 mm, Organic (from drop down)
ii. ii. Monoblock =0.15 mm, Organic (from drop down)

Note: These offset values can be manually changed if desired according to your own determined values.

e. Itis recommended that the “Auto Place” be checked as this will ensure that the part is placed within the printer area of the
platform after offsetting.

f. Click the “Set” button when everything in the “Offset Denture” window looks correct.

g. 3D Sprint will begin offsetting the denture(s) as seen by a progress bar at the bottom of the window and progress clocks
next to the parts in the “Parts List” window.

3D Systems, Inc. 38 p/n 33-D386, Rev. C



h. Note that when offsetting is complete, the denture teeth may appear “mottled” with the gum/base material. This is only an
imaging artifact as the printed teeth will be the selected shade.

i. Currently it is recommended that dentures be printed teeth “down” (for both upper and lower dentures) with the front teeth
positioned toward the front of the build platform (for upper dentures only). If the auto-place has not placed them in this
orientation, please use the “Transform” tool on the ribbon tool to manually adjust the parts.

6. Material Assignment

a. If further material assignment is needed, the “Material” button on the Dynamic Tool bar ribbon menu can be selected.

b. This allows for a range of teeth colors to be chosen and assigned to the denture(s) if desired.
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c. Clicking on the eyedropper and placing it over a part will indicate what the material is assigned to that part.

d. Clicking on a material name will change the eyedropper to a paint bucket which can be used on the parts to assign that
material.

e. Advanced features of the Material Palette allows for user color adjustment of the teeth shades.

Note: Based on the selections made in the Material Selection tab, the expected shade outcome is indicated
below.

7. Saving

a. Save your file often by going to the “File” -> “Save” or “Save As" options on the Dynamic Tool bar ribbon menu.
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8. Printing and Queue

a. When satisfied with the denture plate, the build time and material usage can be estimated using the “Estimate” button on

the Dynamic Tool bar ribbon menu.

b. To send the build job to a printer, click the “Add to Queue” button to your previously selected printer.

Note: This cannot be done if using a Virtual printer.
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c. Inthe “Add to Queue” dialog box the job name can be modified if desired and a job notification e-mail option is available. If
satisfied, click the “Add to Queue” button.

d. After spooling the job, 3D Sprint will switch to the “Queue” tab and will display any other pending build jobs, completed build
jobs, and any jobs currently printing. This is also one location where pending jobs can be re-ordered or deleted as necessary.

e. Clicking on any of the jobs in the queue will display additional information on the right side of the window about that specific
job.

Note: Ensure that the material set contains all three denture materials and is the correct print mode!
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9. Printer Setup and Print Job

a. Onyour NextDent 300 user interface screen, ensure that the job to print is on the Status screen.

b. If this is not the job which is desired to be printed, click on the “Prints” tab and then select the job of interest.
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c. Use the tools at the far right to move the job up or down as needed. Tools are available for duplicating the job file and
deleting it from the printer queue.

d. Return to the Status screen and when ready to start the job, press the triangular “Start” button in the lower middle portion of
the Status screen.
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e. When the build job is complete, the Status screen will appear as below. Press the “Access Platform” button and wait until
instructed to remove the plate from the printer.

8.2 NextDent 300 Support Wax Removal

1. Deplating Parts:

a. After removing the build platform from the printer, place the entire plate in a freezer, preferably on a pre-cooled metal plate
to facilitate cooling. It will take about 15 minutes for the parts to separate from the build plate, but you can check them in 5
minute increments to see if they have released sooner from the build plate.
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b. Prior to returning the build plate to the printer, any residual support material should be carefully cleaned off the plate using
a combination of scrapers (without scratching the anodization), towels and isopropyl alcohol. Both sides of the plate surfaces
should not contain any residue which can interfere with print part adhesion and plate leveling within the printer.

2. Bulk wax removal:

a. Place deplated parts in a basket in a 70C forced air oven to remove bulk support wax and for 2 hours for optimal gum color.

b. Parts should be oriented in the basket to allow for better wax flow off parts and to not pool in denture geometries.

c. Baskets and catch basins are used to encourage air flow, separate, catch, and contain the molten support wax for later
disposal, and for subsequent processing.

3. Fine Wax Removal:

a. Parts are placed in a 65C sonicating mineral oil bath to remove any residual support wax and for 20 minutes for optimal gum
color.

Note: The same baskets used in the bulk wax removal steps are also beneficial in the mineral oil step.

4. Oil Removal:

a. Parts can now be rinsed and soaked in hot (~<70C) soapy (Dawn dish liquid detergent) water bath to remove oil residue.
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b. Typically three hot soapy tub rinses are performed:

i. aninitial soapy rinse (~1 minute)
ii. asoakin fresh soapy water (~10 minutes)
iii. afinal rinse in fresh, soapy water (~1 minute)
c. Lastly, parts are rinsed with plain hot tap water (~30 seconds).
d. Parts are allowed to cool on low lint/lint free towels before subsequent processing.
e. When cool to touch, continue to the next section “Bead Blasting Frost Removal.”

8.3 NextDent 300 Bead Blasting Frost Removal

For this process you will use a Vapor Honing Technologies wet bead blaster with an 8mm nozzle and 25um Aluminum Oxide
Media. Place the denture inside the bead blasting cabinet within reach of the gloves. Place your hands inside the gloves and
pick up the denture. Depress the foot pedal to start the bead blaster. Holding the denture firmly with both hands, continually
rotate the denture in a small circular motion, while moving up and down, bead blasting the denture in this order:

* Right buccal flange and teeth (~1min)

+ Anterior flange and teeth (~1min)

+ Left buccal flange and teeth (~1min)

* Occlusal surface of teeth (~30sec)

+ Palate (if upper denture) or lingual flanges (if lower denture) (~30sec)
+ Intaglio surface (~1min)

Remove the denture from the bead blasting cabinet and rinse with clean water. Blow dry with compressed air, and check for
areas with residual frost. Mark remaining frost with a black Sharpie marker. Place the denture back into the bead blasting
cabinet and blast the marked areas until Sharpie and frost are completely removed. Remove the denture from the bead blaster
and recheck for remaining frost. Repeat as necessary. Allow the denture to dry thoroughly for any remaining frost to be fully
revealed as moisture can inhibit and mask its visibility.

8.4 NextDent 300 Pumice Coarse Polishing

Once all frost has been removed from the denture, prepare your work area for wet pumicing. In the lathe's pumice pan, mix
Navajo (grade 0-1/2) pumice with water; consistency should be loose and watery. Place a wet muslin buff wheel on the lathe
chuck. On low speed, apply wet pumice to the denture and gently polish in the same order it was bead blasted. Because the
bead blaster creates a stippled texture, the facial and lingual surfaces of the teeth must be polished in addition to the base. Do
not polish the occlusal surface of the teeth or the intaglio surface of the denture.

Use a wet B20 lathe brush to polish the denture’s interproximal areas between teeth. Keep the denture wet and moving
constantly to avoid burning.

Rinse the denture with clean water and blow dry with compressed air. Inspect for any remaining stippling on denture base and
teeth. Repeat polishing as necessary.
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8.5 NextDent 300 Fine Polishing

Place a dry muslin buff wheel on the lathe chuck. On low speed, apply Renfert Universal Polishing Paste to the wheel until it

is saturated with polish. Gently polish the denture in the same order it was bead blasted and pumiced, and in every direction,
until it reaches a high shine. This process may reveal areas that need to be re-pumiced as the polish tends to adhere to rough,
textured areas.

Once the denture reaches an overall high shine, scrub the appliance with Dawn dish soap and a denture brush under hot water
to remove any remaining polish.

8.6 NextDent 300 Final Inspection

Under good lighting, inspect the denture for any remaining frost, and stippled, rough, or dull areas. If frost remains, it must
be removed by bead blasting. If stippling, roughness, or dullness remain, this can be removed with wet pumicing, followed by
high-polishing. The denture is complete once it is frost-free with a consistent high shine throughout.
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NEXTDENT 300 MAINTENANCE

Operator Maintenance

For optimal print quality it is critical to follow the operator maintenance routines outlined below at the recommended
interval.

The UI provides reminders when routine maintenance is required.

Note: The printer must be at a Ready state and a clean print platform installed before performing any of the
routines below (excluding the Waste Bag function):

There are several ways a user can tell if maintenance needs to be performed on the printer.

+ A pop up will appear on the Ul letting the user know

+ The user can select Tools > Operator Maintenance from the UI and see when the next maintenance procedure will need to be
performed

« If the user sets up email alerts, an email alert will tell the user maintenance needs to be performed

Use the following procedures to perform maintenance when needed.

9.1 NextDent 300 Operating Environment Recommendations for Best
Performance

Operating Temperature Range: 18-28°C (64-82°F)
Optimal Temperatures Range: 18-24°C (64-75°F)
Humidity: Maintained at 30 to 70% RH

9.2 NextDent 300 Replacing the Particulate Carbon Filter

Replacing the Particulate Carbon Filter
The carbon filter is designed to remove particulates, odors, and gasses from the build area.

Access to this filter is from the front of the machine on the right hand side. Open door, loosen the thumb screw on the door
containing the filter, remove the filter, insert new filter, close door, tighten thumb screw.

Note: This is a customer replaceable item. Particulate Filter with Handle - P/N 310259-00.
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Photo below illustrates a filter that needs to be changed.

Photo below illustrates a filter that is clean and new.
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9.3 NextDent 300 Cleaning Filter Screen V1

Cleaning Filter Screen

There is a screen that is placed above the particulate filter to add extra filtering protection for the filter. This screen will need to be

checked or cleaned weekly.

1. Open the compartment holding the filter screen by loosening the two thumb screws above the particulate filter compartment
(M.
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2. Wearing Nitrile gloves, lift panel up and pull out screen.

3. If more than 50% of the screen is blocked, clean the screen by holding over an approved waste disposal receptacle and brushing
off loose particles from screen. Screen may then be wiped clean using a paper towel with water.

4. Close panel and tighten thumb screw.
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9.4 NextDent 300 Cleaning Filter Screen V2

Cleaning Filter Screen
There is a filter screen that is placed above the particulate filter to add extra filtering protection for the filter. This screen will need
to be checked or cleaned weekly.

1. Open the Filter Door.

2. Wearing Nitrile gloves, slowly pull filter screen out from VOC.

3. If more than 50% of the screen is blocked, clean the screen by holding over an approved waste disposal receptacle and brushing
off loose particles from screen. Screen may then be wiped clean using a paper towel with water.
4. Reinstall the filter screen with the three line markings are face up.
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5. Close Filter Door.

9.5 NextDent 300 Inspecting and Cleaning Planarizer Ducts

Inspect and Clean Planarizer Ducts

Material can get trapped and built-up in the ducts of the planarizer. It is important to periodically inspect and clean these areas.
Follow these steps to inspect and clean the planarizer ducts.

Note: Always wear nitrile gloves when inspecting and cleaning planarizer ducts.
Note: It is recommended to inspect the planarizer blade after each print job

To inspect and clean planarizer ducts:

1. Click on Tools > Maintenance > Inspect Planarizer Ducts .

2. Carriage will move out of the way and planarizer assembly will tilt, allowing access to the ducts (2).
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3. Open planarizer cover to access the planarizer cover to access the planarizer assembly and ducts.

4. Take a foam swab with some Isopropyl alcohol on it and wipe in and around the ducts, taking care to remove all excess
material.

5. Open Top Door.
6. Inspect planarizer housing and if necessary, wipe excess material off with foam swab (4).

7. Using a foam swab, gently wipe out excess material from holes. For stubborn areas, use a bit of isopropyl alcohol on the foam
swab before wiping.

8. When all material has been cleaned up, close top door and carriage will return to Home position.
9. Dispose foam swabs in proper disposal container.
10. On the user interface, click on Tools>Operator Maintenance>Planarizer Ducts>click Yes, that they have been cleaned.
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9.6 NextDent 300 Inspect Planarizer Blade

Inspect Planarizer Blade
The planarizer blade will need to be inspected periodically and wiped off. Excess material can build up over time.

1. Inthe Ul click on Tools > Diagnostics > Inspect Planarizer Wiper Blade

Carriage will move out of the way and planarizer assembly will tilt, allowing access to the blade.

Lift top door.

Open planarizer cover to access wiper blade assembly.

Wearing nitrile gloves, take a paper towel with isopropyl alcohol and wipe off excess buildup off of blade.

uewN

CAUTION: Blade is sharp, wipe blade with care.

6. Close Planarizer access cover.
Close top cover, carriage will return to home position.
8. On the user interface, select Tools>Operator Maintenance>Planarizer Wiper Blade>Yes, that it has been cleaned.

N
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9.7 NextDent 300 Clean Print Carriage Optical Home Sensor

Clean Print Carriage Optical Home Sensor
Pixie Dust Removal from Opto Sensors

Over time pixie dust will accumulate on the Opto sensors and will need to be cleaned off. Follow this procedure for cleaning the
Opto sensors.

Note: Always wear Nitrile gloves when cleaning the Opto sensors.

-
.

From the UI Select Tools > Diagnostics > Inspect Print Carriage Home Sensor. This will move the carriage into position.

Open Top Door.

Lift the carriage cover to gain better visibility of the sensors.

Push y-carriage to move flag away from sensor in order to clean inside of the sensor.

Take a foam swab with isopropyl alcohol on it and gently wipe around the Opto sensors removing all the pixie dust from them.

uewN

6. After all the excess pixie dust is cleaned off the sensors, close the carriage cover.
7. Close the Top Door and carriage will move back into position.

9.8 NextDent 300 - Printhead Cleaning

The Printhead requires regular inspection and cleaning. This procedure may take up to 10 minutes.

Note: Make sure that a clean Print Platform has been installed before starting the cleaning procedure.

CAUTION: Printhead is hot! Use provided cleaning tool and wipes.

1. Begin “Printhead Cleaning” Maintenance Routine from UL
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2. Carriage will move over to the position below to allow for inspection. When prompted, open top door.

3. Place mirror and flashlight in build plate so both heads are visible.

4. Wearing nitrile gloves, open provided pack of presaturated wipe. Unfold it once and slide one end underneath clip on bottom of
cleaning tool. Wrap the wipe around the bumper on top side of tool and hold it in place with your thumb.
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5. Using wipe on cleaning tool, gently clean printhead faceplates. Use caution as print head surfaces are hot and head faceplates
fragile.

a. Areas within green are safe to clean lightly with provided wipe on cleaning tool. Do not wipe towards or on the jetting array
(red circled area). Fold wipe or use a new one once it has picked up residue or some residue has been knocked loose on the
faceplate.

CAUTION: Printhead is hot! Use provided cleaning tool and wipes. Do not touch or attempt to clean the area
circled in red. Any contact in this zone may damage the printhead

6. Inspect edges on left side of print heads. Use foam g-tip wet with IPA to remove material.
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7. Once complete, remove tools and close top door.

Note: The carriage picks up pixie dust and should also be inspected and cleaned when needed during the head
cleaning routine. The same tool provided can be used to assist.

9.9 NextDent 300 Removing Pixie Dust from UV Assemblies (left and right)

Removing Pixie Dust from UV Assemblies (right and left)

Over time, the UV assemblies accumulate a buildup of pixie dust (light coating of material particles) that will need to be wiped off
with a lint free cloth and isopropyl alcohol.

Right UV Assembly

1. Select Tools > Maintenance > Planarizer Ducts.
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2. The print engine will be centered over the platform allowing user access to the UV lamp assembly.
3. Place a paper towel underneath carriage to catch any material that is loosened during the wiping process.
4. Reach underneath to the right UV lamp assembly and wipe pixie dust using a lint free cloth moistened with isopropyl alcohol.

Note: Always wear nitrile gloves and either a protective sleeve or lab coat when performing this procedure to
protect skin from exposure to uncured materials.

Note: When wiping the right UV assembly use care not to touch printhead.

Note: It may be helpful to shine a flashlight where you are wiping for better visibility.

When material is removed, carefully remove the paper towel and dispose of properly.

Left UV Assembly
1. Lift left UV lamp cover up and gently wipe the entire underside of the UV Assembly with a lint free cloth moistened with

isopropyl alcohol.
2. When finished, close cover and top door.
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9.10 NextDent 300 Confirm Jets

Jet Check Routine
Perform this procedure to confirm that all printhead jets are working properly if:

You are installing the printer for the first time, or
The machine has not recently completed a print, or

Completed prints appear to be missing material (support or part material)

Items Needed:

-
.

bl

v oeN

(1) Clean print platform.
Nitrile Gloves

Note: Jet Check Routine can take several minutes to complete.

Purge the printhead by selecting Tools > Diagnostics > Head Maintenance Cycle (1) through the UL
Next select Test Jets (2). If not platform is in the printer, you will be prompted to Access the Platform and install and confirm a
clean platform.

Once the print platform is installed, close the cover to the printer and the jet check routine will execute.

Otherwise Select CONFIRM to start the test.

Once the routine finishes, access the print platform to evaluate the printed image against the Jet Check Evaluation Criteria on
the next page.

If the image is acceptable (Pass), the printer is ready to start a build.

If the image is unacceptable (Fail) repeat steps 1-4.

If Jet Check Print does not pass after the third attempt, the printer will need to be serviced.

Clean the print platform using the Cleaning Print Platform instructions.

There are a number of possible causes for jetting issues which would cause a failed result, some but not all are:
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« Thermal issues in the material delivery system
+ Cabling

+ Electronics and circuit boards

+ Head maintenance system

« Printhead issues

Jet Check Evaluation Criteria

There are three criteria in which to evaluate the Jet Check Test Print. A fail in any of the three criteria results in a fail for the Jet
Check and will require the procedure to be repeated or the printer to be serviced.

Evaluation Criterion 1 of 3: What is the total count of gaps in the part and/or support material side of the print?
Part Material Pass: If there are 10 or less gaps in the part material side of the print
Support Material Pass: If there are 5 or less gaps in the support material side of the print

If both the part and support material pass, proceed to the second evaluation.

Evaluation Criterion 2 of 3: Are there 5 lines between the gaps in the same row of part or support material?

p
Fail Samples

Pass Samples

If all gaps within a single row have 5 lines or more between them, proceed to the third evaluation.
Evaluation Criterion 3 of 3: Are there at least 2 lines between a gap in a row above or below?

When performing this evaluation, only compare rows of part material to other rows of part material and only compare rows of
support material to other rows of support material.

Fail Sample
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Pass Sample

9.11 NextDent 300 Cleaning Exterior Surfaces

Do not remove any outer panels when cleaning the printer. Panels must only be removed by qualified 3D Systems Technical
Support Representatives.

Remove dust from outer surfaces of printer by wiping with a clean, dry, lint-free cloth.
Remove dirt and grease from printer outer surface by spraying all-purpose cleaner on a clean cloth and gently wiping it down.

CAUTION: Use 50% IPA and 50% water with a soft cloth to clean surfaces. Do not use all-purpose cleaners
containing petroleum-based polishing agents such as liquid wax.

Note: Before cleaning, the 3D printer system must be idle to avoid aborting a build.

9.12 NextDent 300 Cleaning Polycarbonate Top Door

Polycarbonate Top Door should be cleaned with a non-abrasive cleaning and damp cloth. Gently wipe surface using dampened
cloth to remove debris.

CAUTION: Do not use cleaners such as Windex™ and paper towels to clean polycarbonate surfaces. Use 50% IPA
and 50% water with a soft cloth. Using anything else will scratch the polycarbonate surface.

9.13 NextDent 300 Cleaning Print Platform

Any time parts are processed, it is a good practice to clean the print platform and re-insert it into the printer. Follow these steps for
cleaning the platform:

1. Use a flat razor blade or putty knife to scrape any excess support material off of the platform. Be careful not to scratch the black
coating on the platform.
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2. Spray the platform with isopropyl alcohol (IPA) and wipe with paper towels.
3. When cleaning the print platform, always clean both sides.

Note: The print platform should be clean and at room temperature before installing and using it in the printer.

9.14 NextDent 300 Cleaning the User Interface

Remove any printed parts before cleaning the user interface. This will prevent the printer from initiating any actions if controls are
accidentally pressed.

Spray a water-based solvent such as Simple Green onto a lint-free soft cloth; do not wipe with a dry cloth or spray cleaner directly
onto touch screen.

Gently wipe dirt and part material residue from touch screen using an ammonia-based glass cleaner on a clean, lint-free cloth.
Do Not Use:

* Adrycloth on the touch screen

* Any cleaning products that contain acetone, MEK or alcohol

* Any abrasive cleaning products

* Using these cleaning products can damage the touch screen.

9.15 NextDent 300 MDM Maintenance

The following general maintenance procedures provided must be accomplished to help maintain high part yield and to reduce the
printer down time.

When changing material cartridges, material may be present in the MDM receptacle after the cartridge is removed. If a large
pool of material is present (bottom is submerged and walls of the cartridge receptacle are reached), do not place a clean material
cartridge into the receptacle, call your reseller/partner.

CAUTION: The MDM cartridge receptacle and material will be warm; avoid touching the sides of the holder during
the cleaning process. Wear heat resistant gloves and goggles.

Cleaning the MDM Drawer

Using Isopropyl Alcohol and a lint free cloth, dampen cloth with the alcohol and clean around the cartridge receptacle.

9.16 NextDent 300 Routine Maintenance

It is necessary to keep the printer clean and free of debris by cleaning up any dust that has collected around the printhead and
the surrounding areas. Depending on the printer usage, it is recommended to clean every week for light usage and every print for
heavy usage.

Items needed

+ Nitrile gloves

« Lint free paper towels or a damp cloth

+ Isopropyl alcohol or similar non-abrasive cleaner
« Vacuum or compressed air hose

Items to clean

+ Beauty plate

+ Inside and outside of Planarizer cover

+ Outside of printer

WARNING: DO NOT CLEAN THE UNDERSIDE OF THE PRINTHEAD (JET STACK). DOING SO WILL CAUSE SEVERE
DAMAGE.
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NEXTDENT 300 TROUBLESHOOTING

The Troubleshooting section is designed to help the user diagnose any anomalies that is happening with the printer before having
to call for service. Most of the everyday things that can occur are listed in this section. If this section does not answer the question
or solve the problem, contact your Certified Partner for service.

10.1 NextDent 300 Printer Status and Fault Code Recovery

The NextDent 300 Series uses codes to identify various fault or status conditions with the printer:

+ Status about the device, for example, cartridges are low on material

+ User-clearable faults, by the user performing cleaning procedures

+ Printer-clearable faults, where the printer is automatically attempting recovery
+ Service required faults, which can only be resolved by a certified partner

Check the Printer Status envelope for current printer conditions.

Codes listed below describe user-clearable and printer-clearable faults:

PRINTER STATUS CODE ISSUE DESCRIPTION CUSTOMER TROUBLESHOOTING
STEPS
+  90-122 - Part Quality May Be The printer may have of had an errorora 1, Check the Fault History list for errors
Compromised delay of over 30 minutes (recovery from that may have cause the delay to
an error, waiting for user intervention) resolve any outstanding issues.
which could impact part quality. 2. Set up email alerts to be notified when

the printer needs user intervention
(new material, empty the waste bag).

* 92-113 - Print Platform front sensor Print Platform sensors may be dirty and 1. Access Platform from the UI > Status
intermittent require cleaning. Tab

*  92-114 - Print Platform rear sensor 2. Open top door
intermittent 3. Remove Print Platform

4. Inspectthe plate sensors and clean
any debris on or around them

5. Replace print platform
6. Close top door

7. Reboot machine from UI > Tools Tab >
Shutdown > Printer Reboot

8. If this does not solve the problem call
your Certified Partner for service

*  92-152 Planarizer motor stall If the print platform is installed 1. Access Platform from the UI > Status
incorrectly or has material on the bottom, Tab
it allows thg print platfqrm to be higher 2. Open top door
than the printer thinks it is and a minor .
. . 3. Remove Print Platform
impact could occur, stalling the motor. . .
4. Clean both sides of the print platform
5. Replace print platform
6. Close top door
7. Reboot machine from UI >Tools Tab >
Shutdown > Printer Reboot
* 93-120thru 123 93-120 thru 123 & 93-130 thru 133 - When 1. Check the affected cartridge and
*  93-130 thru 133 Support/part these errors are detected, the support verify:
cartridge 1/2 fill timeout and build materials are trying to recover 2. Cartridge has material
*+  93-134 thru 137: Support/part from filling errors 3. Cartridge is fully inserted
* 93-168-171 - cartridge should not be  93-134 thru 137 - filling errors 4. Cartridge vent cap has been loosened
empty cartridge 1/2 check needed 1/2 turn counter-clockwise and is clear

Printer thinks there should still be

o ; of material.
material in the cartridge
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PRINTER STATUS CODE

* 93-111/93-113 - Support / Build Head
Res max dose count exceeded

* 93-114 - Unable to fill the printhead
for purging

+ 93-200, 93-201 Excessive support/part
material used

* 93-295-296 - Insufficient material

* 94-203 Planarizer Contact Calibration
Failed

* 94-104 Printer Slowing Down
*  95-118 Build Chamber Too Hot

* 92-157Y Axis Motor Cannot Home

* 94-207 Clean Print Carriage and
Optical Home Sensor

* 94-301 - 307 - Job Aborted:

Image Slicer Abort reasons:

ISSUE DESCRIPTION

Printer is having issues dosing the
printhead

Not enough material available

Printer is using more material than can
be accounted for.

Insufficient material use in the printhead.

Printer keeps printing but no material is
being put down.

Planarizer Contact Calibration Failed prior

to printing, the printer calibrates the
planarizer gap. If it fails, the printer
will wait fo the user to remove and re-
position the plate.

Printer slowing down to cool.

Build Chamber Too Hot while printing,

if the printer shows slowing down to
cool, the build chamber is above optimal
temperature. If it continues to exceed
temp, the printer will pause printing until
the temperature goes down.

Sensor may be dirty.

The printer detected an issue requiring
the job to be aborted.

CUSTOMER TROUBLESHOOTING
STEPS

The printer may delay for several minutes
while it is trying to recover, if no material
is available for printing.

1. The printer will try to recover
automatically from this issue

2. The printer may go through several
Error states and reboot in its recovery
process.

3. Ifitis not able to ultimately recover,
it will reboot into a Diagnostics mode
for the user to call service.

The printer may not have enough
material to perform standard
maintenance, like purges. Please verify.

+ Cartridge has material

« Cartridge is fully inserted

+ Cartridge vent cap has been loosened
a 1/2 turn counter-clockwise and is
clear of material.

If Cartridges have just been inserted and
are cold, it may take 60-90 minutes to
warm to an operational temperature.

Check the printer for any material
leakage and contact a Certified Partner
for service.

Call service

-
.

Access Platform from the UI > Status
Tab

Open top door

Remove print platform

Clean both sides of the print platform
Replace print platform

Close top door

ousrwN

-
.

Check ambient temperature, optimal
temperature range is 18°-24°C
(64°-75°F).

Verify that the particulate filter and
the screen above the filter are not
plugged. Replace as necessary.

Make sure the printer is not next to a
window in direct sunlight.

4. Make sure the back of the printer is
12" from the wall.

15

Clean Print Carriage Optical home sensor.
See Cleaning and Maintenance section
for cleaning sensors.

Review cause for the aborted reason and
retry the print job. Call service if required.
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PRINTER STATUS CODE

101 - An internal error has been
detected in the Image Slicer service
102 - Aslicer error has been detected
103 - An error was detected in the
slicer while processing a layer image

Contact service for information on
resolving these issues.

301 - Print Job Aborted: The build
chamber was too hot to continue job.
Check ambient temperature and filter.

302 - Print Job Aborted: Z-axis and
layer count mismatch. Call service to
inspect z-axis if error occurs again.

303 - Print Job Aborted: The top door
was opened while printing.

304 - Print Job Aborted: The planarizer
cover was opened while printing.

305 - Print Job Aborted: The rear
service panel was removed while
printing.

306 - Print Job Aborted: Issue detected

with the carriage board. Call service to
inspect carriage board and cabling.

307 - Print Job Aborted: Issue detected
with the PDAC board. Call service to
inspect PDAC board and cabling.

ISSUE DESCRIPTION

10.2 NextDent 300 Non-Fault Code Recovery

PROBLEM

The printer will not power up

The UI displays a message "Printer
Disconnected"

DESCRIPTION

The Ul is off and there are no sounds
coming from the printer.

The printer lost its connection and is non-

responsive.

CUSTOMER TROUBLESHOOTING
STEPS

LooNOGAWN=

TROUBLESHOOTING STEPS

Turn the power switch off

Wait for 30 seconds

Unplug the power cord

Wait for 10 seconds

Make sure the power switch is off
Plug in the power cord

Wait for 2 seconds

Turn the power switch on

The UI should be powered on and the
printer should start making turn on
initialization sounds within the next
minute. If this does not happen please
contact your local service provider

Turn the power switch off

Wait for 30 seconds

Unplug the power cord

Wait for 10 seconds

Make sure the power switch is off
Plug in the power cord

Wait for 2 seconds
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PROBLEM

User Interface

Powered up, non-responsive.

UI stuck in a specific routine

UI black, machine powered on

DESCRIPTION

The UI appears to be hung, the printer is
powered on, the Ul is displaying a screen

(not blank), but is non-responsive.

The UI appears to be stuck in a specific

routine, such as aborting a job, accessing

the platform, etc., for at least 1 minute.

The machine is powered on, fans and
other machine noises are observed.

o9
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TROUBLESHOOTING STEPS

Turn the power switch on

The UI should be powered on and the
printer should start making turn on
initialization sounds within a minute
or so.

The UI should be ready and
communicating with the printer in
2 to 3 minutes. If this does not
happen please contact your local
service provider

Turn the power switch off

Wait for 30 seconds

Unplug the power cord

Wait for 10 seconds

Make sure the power switch is off
Plug in the power cord

Wait for 2 seconds

Turn the power switch on

The UI should be powered on and the
printer should start making turn on
initialization sounds within a minute
or so.

The UI should be ready and
communicating with the printer in
about 2 to 3 minutes. If this does
not happen please contact your local
service provider

Turn the power switch off

Wait for 30 seconds

Unplug the power cord

Wait for 10 seconds

Make sure the power switch is off
Plug in the power cord

Wait for 2 seconds

Turn the power switch on

The UI should be powered on and the
printer should start making turn on
initialization sounds within a minute
or so.

The UI should be ready and
communicating with the printer in
about 2 to 3 minutes. If this does
not happen please contact your local
service provider

Turn the power switch off

Wait for 30 seconds

Unplug the power cord

Wait for 10 seconds

Make sure the power switch is off
Plug in the power cord

Wait for 2 seconds

Turn the power switch on
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PROBLEM

Material Delivery/Material Cartridges

Excessive material in the cartridge
receptacle

Cannot insert material cartridges

Cartridge cannot be removed from the

machine

Material delivery drawer won't open

Material cartridge leaks material

Waste bag stuck to liner

DESCRIPTION

A visible amount of material remains in
the cartridge receptacle

The material receptacle will not allow a
bottle to be inserted.

The release button is pushed, but the
cartridge can't be removed.

The material delivery drawer locks

during material delivery maintenance or

to protect the machine from damage
caused by inserting or removing cold
material bottles

When the material cartridge is removed
from the printer, material leaks out

The waste bag cannot be removed from

the waste bag liner

1.

1.

1.

1.

2.

1.

1.

TROUBLESHOOTING STEPS

The UI should be powered on and the
printer should start making turn on
initialization sounds within a minute
or so.

The UI should be ready and
communicating with the printer in
about 2 to 3 minutes. If this does

not happen please contact your local
service provider

Do not insert a new material
cartridge.
Call your local service provider.

Do not attempt to load support
material cartridges into the printer
until it has warmed up for 20 minutes.
Verify that the material cartridge is
fully inserted. The cartridge should
click into place.

If the problem persists, contact your
local service provider.

Confirm that your machine is warm,
do not attempt to remove cold
material cartridges, if the printer is at
ready state and the problem persists,
contact your local service provider.

This is normal behavior.

The material delivery drawer will
unlock when it is safe to do so.

Prior to removing the cartridge, rotate
the cap clockwise to close.

Push the cartridge release button,
then remove the cartridge. Note that
pushing the button while removing
the cartridge could result in material
leaking from the cartridge.

If there is excess material found in

the bottom of the material receptacle,
contact your local service provider.

Remove the rigid waste bag liner from
the machine.

To avoid a mess, remove the liner
over a container that is designated for
waste material. Use caution, removing
the bag may result in a tear and
material may leak out of the waste
bag.

To continue printing, install two waste
bags.

Contact your local service provider
and order a rigid liner replacement.
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PROBLEM

Material cartridge inserted, not
recognized by printer

Status envelope - Print platform has
material on it

Other

Machine noise-loud clicking

Machine odor-unpleasant

Print platform not detected

Printer will not come out of Warming
State

DESCRIPTION

The material cartridge is inserted, but not 1.

detected. The material identification tag
can be missing or is damaged.

A print job was completed and a new
print platform has been installed. The
next print job will not start, status
envelop reports "Print platform has
material on it"

The machine occasionally makes a loud,
rapid clicking noise.

After printing for a period of time, an
odor from the printed part material can
be detected.

The print platform is installed, but not
detected.

The printer seems to be stuck in the
warming state

[

TROUBLESHOOTING STEPS

Confirm that the material cartridge
identification tag is still in place. The
label is located on the front of the
cartridge.

Using the same material type, insert
a different bottle into the material
receptacle (swap cartridges if another
cartridge is loaded in the other slot.
If the new cartridge is detected

by the printer, there is something
wrong with the RFID tag on the
non-detectable cartridge. Replace
the material cartridge. If the new
cartridge is not detected contact your
local service provider.

Select Access Platform from the
printer UL

Remove the print platform
Re-install the print platform. Verify
that the platform is not skewed and
is placed flat in the printer.

If you were not prompted with a
message that a new platform was
installed, contact your local service
provider.

This is normal behavior. The material
delivery system is moving material
throughout the printer.

Replace the printer Particulate Filter.
Increase the air exchange rate of
room where the machine is operated.
Move the printer to a more ventilated
open area.

Access Print Platform from the UI
Remove the installed print platform,
and reinstall. Confirm that the
platform is not skewed and is placed
flat in the printer

If the problem persists, contact your
local service provider.

If the machine was recently powered
up, it will take just over an 1 hour

to fully warm the printer up and
transition to the Ready State.

If the printer has been warming

for more than an hour, confirm

that material bottles are loaded in
the printer and that they contain
material. Both support and part
material is required, the machine will
stay in the Warming state until both
types of material are detected and
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PROBLEM DESCRIPTION TROUBLESHOOTING STEPS

warmed to the appropriate printing
temperatures.

3. If material has been loaded and the
problem persists, contact your local
service provider.

The printer has slowed down while The printer is printing, but at areduced 1. The optimal ambient printing
printing speed temperature range is 18-24 C (64-75
F), verify that the room in which
the printer is installed is within this
range, reduce the room temperature
as needed.

2. Verify that the printer has 12" of
clearance behind the machine to
ensure proper ventilation.

3. Ifthe printer is located next to a
window or exposed to direct sunlight,
relocate the printer, if the problem
persists, contact your local service
provider.

Machine Powered On, UI Blank/Black

Issue: The printer has power, fans are on, umbilical thermals are working, LED lights can be observed on the circuit boards, but the
Ul is blank/black and appears dead.

Probable Causes: The Ul is not powered, software issue, UI SD card missing/not inserted, cable issue.

When the Ul receives power, it will flash on and then appear to go blank, but if it is powered, there will be a small amount of visible
light in/around the display.

Troubleshooting Steps

Power cycle the printer, if the UI doesn't come up Contact a Certified Partner for service.

10.3 NextDent 300 Part Quality Issue Recovery

PROBLEM DESCRIPTION TROUBLESHOOTING STEPS

Missing Material:

Missing Jets:
Missing material in part (left to right)

Dragging:

Part has groove(s) of material missing
often in the in the shape of a line from
the left to right direction. If the part

is across multiple lanes (front to back)
missing material will occur across each
lane in the same relative location and
width.

Part and verification wall look as if

Perform Confirm Jets procedure

If the jets do not clear after three
attempts, contact certified partner for
service.

Look for material buildup on the

something has been dragged across the
surface of the part. There may be missing
material in the part and/or extra material
dragged or smudged outside the partin

bottom of the print engine by looking
horizontally across the surface, see
At a Glance section for print engine
location. Clean any material that

Missing material in part (left to right)

the areas of missing material.

is hanging down from underneath
the print engine. Use the Inspect
Planarizer Blade routine to clean the
planarizer access cover. See Inspect
Planarizer section for assistance.
Wearing nitrile gloves, rotate the
planarizer access cover so that the
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PROBLEM

Horizontal line or appearance of missing
layer

Gap in material

Extra Material:

Smearing:

Support material extends beyond part or
is present on surfaces of part after post
processing

Dripping

DESCRIPTION TROUBLESHOOTING STEPS

planarizer blade is accessible. Clean
off the edge of the planarizer blade,
See Inspect Planarizer section for
assistance. If additional dripping
and/or material buildup remains on
the bottom of the print engine,
contact your certified partner for
service.

3. Clean any material off the bottom
of the print engine including
the planarizer waste trough, the
printhead mount, the air plenum'’s,
the UV lamp or anywhere else. Always
keep the printer clean.

The printed part has a horizontal line 1. Apause longer than 10 minutes
through the entire part or appears to during a print job may result in this
have a missing layer of material. defect. To eliminate, promptly remove

full waste bag and load new part
and support material cartridges when
requested.

2. Email alerts can be set up to provide
notification of close to full/full waste
bags as well as low/empty material
cartridges. See User Interface section
for directions to set up email alerts.

The printed part has a gap in the material The printer is out of calibration, contact
1/3 and/or 2/3 of the way across the part  your certified partner for service.

(front to back when standing in front of

the printer).

Parts have observable support material 1. Make sure the planarizer is clean.

extended beyond where the part should Perform the Inspect Planarizer Blade
be in the left to right direction. Extra procedure found in this manual.
material described as "flames" or "spurs” 2, Look for material buildup on the
of material. bottom of the print engine by looking

horizontally across the surface, see
"At A Glance" section for print engine
location. Clean any material that is
hanging down from underneath the
print engine.

3. The extra support material can often
be removed with a nylon brush or by
simply rubbing the surface with a soft
cloth.

4. Orientating the parts at a different
angle can reduce or eliminate the
issue until your service provider
arrives.

5. 1If the problem persists, contact your
certified partner for service.

Material has dripped on the part or in the 1. Perform the Inspect and Clean
build chamber area. Planarizer Ducts routine.
2. Itis recommended to clean more
frequently for M2E elastomeric and
M2S specialty material families.
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PROBLEM

Snow:

Snow like material in the build chamber

Bump

Discoloration:

Blotches:

Clear or white material has yellow
discoloration areas or spots

Color mixing

Printed part changes shade

Part color fades

DESCRIPTION TROUBLESHOOTING STEPS

3. If the problem persists, contact your
certified partner for service.

The development of "snow" within the 1. To reduce the amount of snow

build chamber is normal. within the build chamber, increase the
frequency of printer maintenance. See
the Troubleshooting and Maintenance
Best Practices Section of this manual
for information.

2. Ifthe part has been damaged from a

buildup of snow, contact your certified
partner for service.

The part has a bump or a ridge of extra Contact your certified partner for service.
material 1/3 and way 2/3 of the across
print platform (orientation front to back).

Clear material appears to have yellow 1. Reposition the part so that tall

spots. sections and short sections of the
print job are in different lanes (front
to back when standing in front of the
machine).

2. Position tall parts towards one end
(left ot right) of the platform and
shorter parts on the other end. This
will avoid the shorter parts being over
exposed to the UV Lamps during the
build of the taller parts.

3. For smaller parts, position the parts
in the center of a printing lane. The
UV lamp intensity overlaps at the edge
of printing lane boundaries and can
increase yellowing in these locations.

4. For smaller parts that did not take
long to post process, yellowing can
sometimes be reduced by putting the
parts back into the oven at 65°C to
70°C for a few hours.

5. Always make sure the UV Lamp are
clear of excess material.

The printed material appears to have 1. Inserting a different part material

small areas of lighter or darker color. color can result in a small amount of
color mixing which may show up on
the printed part. This will clear on its
own.

2. Ifyou are concerned with mixing on

your next printed part, perform a
Material Change Wizard routine to
flush the unwanted material.

The top portion of the part does not have Part material has a small amount of lot

the same shade as the bottom portion of  to lot variation. Prior to printing, confirm

the part. that all part material needed for the job
has the same lot code.

The printed part fades from clear to Parts can fade or change color over time.
yellow (when printing with clear material  To reduce the change in color, limit part
exposure to light and heat sources.
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PROBLEM

Permanent marks on part after post
processing

Surface Finish:

Top surface shine and matte

Side surface vs. top/bottom surface

Degraded fine details

Surface mottle, visual non-uniformity or
too hot.

Part Distortion:

Upward part curl on flat surfaces relative
to the build plate.

DESCRIPTION

or black to gray) when printing with black
material.

The finished part has an outline and
discoloration in the shape of another post
processed part.

The top horizontal surface of the printed
part has some areas that are shiny
(glossy appearance) and some areas that
have a matte finish.

The top/bottom surfaces appears smooth
while the side surfaces appear to be
rough or have steps of material.

The surfaces appear degraded and
fine details are either missing or not
completed as designed.

The surface of parts appears spotty or
mottle in texture. Sharp corners may be
rounded - especially the upward facing
features.

Part is bowed or curled and surface is
no longer flat. Curling occurs in the z-
axis (vertical direction) from the print
platform. The curls occurs prior to post
processing the part.

TROUBLESHOOTING STEPS

Avoid stacking or overlapping parts when
post processing.

In 3D SPRINT, position the part at a slight
right angle to the horizontal surface prior
to sending to the printer.

The printer encapsulates support (wax)
material when printing which will cause
the sides to have a matte finish.
Horizontal surfaces may have a glossy
appearance due to the print process. To
eliminate gloss, position the partin 3D
SPRINT so that horizontal surfaces are
minimized.

1. Make sure the part has followed

the MJP general designee rule: i.e.,
fine details are not too small (<200
microns).

2. Check if defects are associated with

other failures such like 'Surface
mottle, visual non-uniformity, or too
hot' or 'the printer has a limitation
when printing up facing engraved text
or lines.'

1. Check ambient temperature, optimal

temperature range is 18°- 24°C
(64°-75°F).

2. Verify that the particulate filter and

the screen above the filter are not
plugged. Replace as necessary.

3. Make sure the printer is not next to a

window in direct sunlight.

4. Make sure the back of the printer is

12" from the wall.

5. Print parts with large flat surfaces

vertically on the print platform.

1. Check ambient temperature, optimal

temperature range is 18°-24°C
(64°-75°F).

2. Verify that the particulate filter and

the screen above the filter are not
plugged. Replace as necessary.

3. Make sure the printer is not next to a

window in direct sunlight.

4. Make sure the back of the printer

is 12" from the wall and has good
ventilation.
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PROBLEM

General part distortion during or after
post processing

Dimensional accuracy

Other:

Part won't adhere to the print platform

DESCRIPTION

Part is bowed, curled or warped and/or
surface is no longer flat after post
processing the part.

The completed part does not match the
size desired.

The printed part is not building correctly

on the print platform, the support
(wax) material won't adhere to the print
platform.

TROUBLESHOOTING STEPS

Rotate the parts 90°such that parts
with large flat surfaces are 90° relative
to the print platform.

It is recommended to print in M2G
materials.

Lower the oven temperature for parts
with large flat surfaces.

Complete all post processing steps of
the part.

It is recommended to lay the

part flat everywhere at any

time during post processing:

oven, rinse,cleaning,cooling,drying.
For irregular parts, it is recommended
to use a fixture to hold the part flat.
After post processing and cleaning
the part, clamp the part against or
between a flat surface and place back
in the oven to flatten. Once the part is
flat, remove from the oven, keep the
clamp on the part until cool.

Consider using a more rigid material
(Rigid Tan vs Engineering Armor) for
thin features that tend to distort
during post processing. Parts can be
placed back into the oven after post
processing and they will often return
to their printed shape.

Additional supporting structures can
be used for fragile overhanging parts
that sag under their own weight. Cool
the parts in their desired shape.

See the Shrinkage Compensation
Procedure to determine the Shrinkage
Compensation values. See Shrink
Compensation section of the User
Manual for assistance.

Input new values into 3D SPRINT and
reprint the part.

Never print with a cold print platform.
When using a print platform where

a part was just removed, allow the
print platform to warm up to room
temperature prior to starting the print
job.

The print platform must be
completely clean prior to use. Scrape
any residual wax from the print
platform and wipe with IPA prior to
use. It is important that both sides of
the print platform are clean.

Remove any debris from the printer
prior to installing the print platform.
Debris under the print platform may
cause the print platform to sit at an
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PROBLEM

Verification wall tipped/broken near base

Tall and thin part(s) fall over during
printing

The printer has a limitation when printing

up facing engraved text or lines.

Printhead Misalignment: This condition
should only be observed on the teeth,

as proper alignment between the support

structures and the gums is essential.

DESCRIPTION

The verification wall has tipped/broken
off near the base and fallen onto the
printed part. Sprayed material appears

on the right side of the build chamber. A

pause in the print job may result in the
verification wall cooling and becoming
brittle. Upon resuming the print job,
the planarizer contact may cause the

verification wall to fall over onto the print

job.

Very tall and /or thin parts placed vertical

in the z-direction appear to have been
partially printed and then broke off the
build plate. Debris from the printhead
may be seen in the build area or on the
verification wall from the part material

being jetted into the build area instead of

onto the broken part.

All edges are not sharp but beveled when

the fine features are printed upward
facing.

1. On Plate: Teeth have blisters around

them or a shadowy coating. This is a

directional artifact and when present

will appear on the same side of the
affected parts

2. De Waxed: With support removed,

this leaves an atypical shininess to

the teeth where there was significant
separation between the support and

the teeth material.

TROUBLESHOOTING STEPS

angle resulting in a collision between

the print engine and the part.

To avoid, do not allow pauses in the print
job such as waste bag replacements or
empty material cartridges.

-
.

Rotate the parts so that the part long
dimensions is not directed in the z-
axis

Rotate the parts to reduce the z-
height and add more support for
stability.

Place multiple thin parts close to each
other so that they support each other
during the build process.

Add additional sacrificial parts to the
build near the tall parts for improved
stability.

Print the same part with the engraved
text or lines in a rotated angle against
XY plane or facing downward(as
printed).

Please contact 3DSystems directly to
schedule service visit. Our team will assist
you in arranging the appropriate support.
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PROBLEM

Printhead Misalignment: This condition
should only be observed on the teeth.
It can be seen as extremely white
encapsulation on-plate

DESCRIPTION

3. Bead Blasted: Even with bead blasting,
there is a ledge/lip still remaining, and
accuracy is compromised.

1. De Waxed: Shiny Teeth

2. Bead Blasted: Surface Roughness

TROUBLESHOOTING STEPS

Please contact 3DSystems directly to
schedule service visit. Our team will assist
you in arranging the appropriate support.

1.

Shiny Teeth: Since this appears to be
a head-to-head alignment sensitivity,
results may vary slightly between
lanes. Lane 2 often provides the
most consistent output due to its
calibration role, with Lanes 1 and

3 typically following Additionally,
printing teeth in a downward
orientation has been shown to help
minimize common artifacts such

as surface shine and triangular
distortions.
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PROBLEM DESCRIPTION TROUBLESHOOTING STEPS
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NEXTDENT 300 PARTNER - CUSTOMER SUPPORT

Note: Whenever you have a problem or a question it is best to contact your reseller directly first.

If the certified partner cannot help you then there is a Customer Support Hotline you can use. If you receive an unrecoverable
error message, or if you need to contact us for another problem, you may contact our Customer Support Hotline. Before you call
Customer Support with a problem or question, please make sure that you have the following information:

« The serial number of your NextDent 300 is printed on a label inside the filter door or by accessing the UI and selecting Tools >
Printer Info.

+ A brief description of the problem, including the exact error message.

*  When the problem occurred; for example, when you submitted a job, during the beginning or the end of a print, or after power
off recovery, etc.

Customer Support Hotline

General

NextDent 300 service procedures must be performed only by a 3D Systems-certified service technician unless this guide explicitly
states otherwise. If your 3D printer system needs service, contact 3D Systems Technical Support at the following numbers:

* Inthe United States or Canada, call 800-793-3669
« In Europe, call +49-6151-357357

You can also contact your local 3D Systems representative.

3D Systems' support portal is located at http://www.3dsystems.com/support
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NEXTDENT 300 LEGAL NOTICES

Copyright and Corporate Identity

Copyright 3D Systems, Inc. All rights reserved. Subject to change without notice. This document is copyrighted and contains
proprietary information that is the property of 3D Systems, Inc. No copies of the document may be sold or given to any person or
other entity.

End User Software License Agreement

Certain Third Party Software Programs may be contained in the 3D Printer firmware and require the following notifications:
Portions of this software (Win 10) Copyright © Microsoft 2022.

Portions of this software (VxWorks) Copyright © Wind River Systems, Inc.

Portions of this software (Android UI) Copyright © 1995-2015 Interionatal Business Machines Corporation and others. All rights
reserved.

Portions of this software (zlib) Copyright © 1995 - 2017 Jean-loup Gailly and Mark Adler
Portions of this software (mini-gmp library) Copyright © 2007 Free software Foundation, Inc.

Portions of this software (Apache License 2.0) Copyright © 2017 The Apache Software Foundation, Licensed under the Apache
License, Version 2.0.

Portions of this software (LibTIFF) Copyright © 1988-1997 Sam Leffler, Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without
fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related
documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to
the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF ORIN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Portions of this software (Boost) Copyright © Beman Dawes, Daniel Frey, David Abrahams, 2003-2004 Copyright Rene Rivers
2004-2005. The Boost license is open source; the Open Source Initiative certified the Boost Software License 1.0 in early 2008.

Portions of this software (7-Zip) Copyright © 1999-2017 Igor Pavlov.

Portions of this software (Putty) Copyright © 1997-2017 Simon Tatham.

Portions of this software (Notepad++) Copyright © 2007 Free Software Foundation, Inc.
Portions of this software (TightVNC) Copyright © 1989, 1991 Free Software Foundations, Inc.
Portions of this software (Tinyxml) Copyright © 1995-2017 Jean-loup Gailly and Mark Adler.
Portions of this software (Minicsv) Copyright © 2015-2017 Frank Denis.

Libpng versions 1.0.7, July 1, 2000 through 1.6.30, June 28, 2017 are Copyright (c) 2000-2002, 2004, 2006-2017 Glenn Randers-
Pehrson, are derived from libpng-1.0.6, and are distributed according to the same disclaimer and license as libpng-1.0.6 with the
following individuals added to the list of Contributing Authors: Simon-Pierre Cadieux, Eric S. Raymond, Mans Rullgard, Cosmin
Truta, Gilles Vollant, James Yu, Mandar Sahastrabuddhe, Google Inc., Vadim Barkov.

Portions of this software (Google-test) Copyright © 2008, Google Inc. All rights reserved.

Portions of this software (Rapidjson) Copyright © 2015 THL A29 Limited, a Tencent company, and Milo Yip. All rights reserved. The
Msinttypes r29 Copyright © 2006-2013 Alexander Chemeris. All rights reserved.

Portions of this software (SimpleJSON) Copyright © 2006 Bob Ippolito.

Portions of this software (SQLite) Copyright © 2008-2012 Zetetic LLC. The code for SQLite has been dedicated to the public domain
by the authors.

Portions of this software (JPEG) is Copyright (C) 1991-1998, Thomas G. Lane. All Rights Reserved except as specified below.
Portions of this software (Chilkat) Copyright © 2000-2017 Chilkat Software, Inc. All rights reserved.
Portions of this software (OpenDHCP) Copyright © 2007 Free Software Foundations, Inc.
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NEXTDENT 300 BASIC REGULATIONS

3D Systems has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate
interference caused or received by this printer in a typical office environment.

FCC Class A Digital Device

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to
correct the interference at their own expense.

Changes or modifications not expressly approved by 3D Systems could void your authority to operate this equipment.

RFID Radio Compliance - FCC / ISED / EU

This product generates 13.56 MHz using an inductive loop system for radio frequency identification (RFID). The RFID system
complies with the following regulations:

+ FCCPart15

« ISED RSS-210 and RSS-Gen

* European Directive 2014/53/EU (RED)

* And all other applicable local regulations

Operation of this device is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

FCC & IC Transmitter Identification
This device contains a certified RFID transmitter module:

* FCCID: 2ADGF-NEXTDENT
+ ICID: 12666A-NEXTDENT

Access to the transmitter is available to authorized service technicians via standard enclosure access methods (e.g., use of common
tools and removal of covers).

RF Exposure & Occupational Use Notice

This equipment is intended for use by trained personnel in occupational or controlled environments only. It complies with FCC
and ISED RF exposure limits for such environments. This device is not intended for use by the general public.

To comply with RF exposure requirements, a minimum separation distance of 20 cm must be maintained between the
equipment and all persons during operation.

Industry Canada (ISED) Notice
English:
This Class A digital apparatus complies with Canadian ICES-003.

This device complies with Innovation, Science and Economic Development Canada licence-exempt RSS standards. Operation is
subject to the following two conditions:

(1) This device may not cause interference; and

(2) This device must accept any interference, including interference that may cause undesired operation.
Frangais:

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

Le présent appareil est conforme aux normes CNR d'Industrie Canada applicables aux appareils radio exempts de licence. Son
fonctionnement est soumis aux deux conditions suivantes : (1) 'appareil ne doit pas produire de brouillage; (2) 'utilisateur

de l'appareil doit accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le
fonctionnement.
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European Union

CAUTION: This is a Class A product. In a domestic environment, this product can cause radio interference in which
case the user could be required to take adequate measures.

In order to allow the equipment to operate in close proximity to Industrial, Scientific and Medical (ISM) equipment, the external
radiation from the ISM equipment may have to be limited or special mitigation measures taken.

Changes or modifications to this equipment not approved by 3D Systems can void the authority of the user to operate this
equipment.
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NEXTDENT 300 GLOSSARY

Print Platform - Removable platform on which parts are built. Support material adheres the part to the print platform and is
removed from the printer once the job is complete.

Part Material - Is an ultraviolet (UV) curable material used to build the parts. Always wear nitrile gloves, lab coat and safety glasses
when handling any uncured part material.

Top Door - The chamber door prevents harmful UV radiation from escaping the build chamber during the build process. The
chamber door must be closed prior to starting or resuming a build job and is locked when a build is in progress.

Log - A log file is a zip file of logs used by service for resolving potential problems that may occur with the 3D printer system.

Head Maintenance Station (HMS) - The head maintenance station cleans the printhead by allowing it to purge into the waste bin
as well as wipe the printhead clean from any remaining material.

Job Scale Percentage (Job Scale %) - This is used to re-size parts during the build process.

Material Change Wizard - A process used to switch from one part material type to another. The existing part material that was last
used from the printer must be removed, and the material cleaned from the printer before adding a different part material type.

Material Delivery Module (MDM) - Stores and feeds the materials to the printer during the build process. The MDM holds two
support cartridges and two part cartridges.

Post Processing (Finishing) - Is the final process to remove support material from parts and clean the parts to a smooth finish
prior to surface finishing and coating.

Print Engine - The Print Engine contains major systems such as the Printhead, Planarizer, and UV Lamp Assembly.

Print Process - Three dimensional solid parts printed by the printer consist of two materials (support material and part material).
The support material is a wax based material providing adhesion to the print platform, as well as, providing material used to
produce supports required to build the model. The part material used to build the parts is an ultraviolet (UV) curable material. After
a layer of material is deposited on the build chamber, the part is exposed to a UV flash lamp. The UV energy is absorbed by the
material converting a liquid part material to a solid polymer. When the build is complete the part (consisting of the two materials) is
adhered to the print platform by means of the support material.

Build Chamber -The area designated for the part to be built in.

Sensitizer - Uncured part material is a sensitizer, and can cause allergic reactions if it contacts skin without personal protection.
Always wear nitrile gloves, lab coat and safety glasses when handling any uncured part or waste material. Sensitization can build
up over time and what originally may not have caused an allergic reaction could begin to cause a reaction with over-exposure to
part material.

Shrink Comparison Percentage (Shrink Comp %) - Used to adjust for expected shrinkage during the build so actual part
dimensions more closely match actual dimensions.

Support Material - Wax based material that provides adhesion to the build platform and support for down facing surfaces and
open volumes within the parts.

User Interface (UI) - User Interface is built into the top of the printer. Various features can be controlled and checked by the UI,
such as the status of a print job, materials in the printer, shutdown the printer and well as checking on certain settings within the
printer.

UV Lamp Assembly - The UV Lamps cure the part and support material as the printer is building a part.

Waste Bag - Plastic bag designated to catch the waste material from the building process. The waste bag is located in the MDM
behind the Support Material. Always wear nitrile gloves, lab coat, and safety glasses when handling any uncured part or waste
material.

Waste Material - Any uncured support and/or part material generated during a build process. Always wear nitrile gloves, lab coat,
and safety glasses when handling any waste material.

X-Axis - The orientation of the part from left to right on the build platform.
Y-Axis - The orientation of the part from front to back on the build platform.
Z-Axis - The orientation of the part height on the build platform.

.stl File - The files created using a three-dimensional solid Computer-aided design (CAD) software. These files are used to produce
parts.

.3dprint File - Files that have been created and saved by the client software 3D SPRINT.
3D SPRINT - The client software used to create parts and send them to the printer.
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@ NEXTDENT 300 DECLARATION OF CONFORMITY (DOC) AND DATA
LABEL

EC Declaration of Conformity (DoC)
Data Label
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https://printer-docs-public.s3.amazonaws.com/MJP-NextDent-300/DoC/NextDent%20300%20CE%20DoC%20%28CD-000316-ENG_A%29.pdf
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